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Abstract: While technology has been a blessing to the overall population when used correctly,
corporations use data to make data-driven choices, and data Visualize is a crucial aspect.
Individuals are more reliant on instant communication and internet access than ever before.
Knowledge that was previously guarded yet distributed locally is now connected and shared
online among people in the digital era like never before. The ability to access this data opens
up a world of possibilities, and in order to make these possibilities a reality, individuals must
use data to solve issues. Ironically, as a result of a worldwide pandemic, individuals all across
society are seeking trustworthy information about the Coronavirus. Power BI is a significant
factor in this circumstance, because this is an incredibly strong tool for quickly displaying
large amounts of data. Power BI covers a broad range of datasets, and the dashboard
investigates the consequences of viruses, their spread and intensity, and aims at providing an
educated assessment of the issue. This dashboard provides dynamic and concentrates on
keeping the users engaged with the most recent data on coronavirus patterns in all countries
throughout the world, providing the end-user with a benchmark across different areas of the
world. It will illustrate how the spread and deaths have progressed over time. At a glance, this
dashboard would transmit critical data, highlight the most impacted regions, and include
indicators that would keep track of significant statistics, motivating the end-user to grasp the
unpredictable aspect of the present position and take appropriate preventative actions.
Keywords: Visualization, dashboard, pandemic, power bi, business intelligence, data analysis
_________________________________________________________________________
1. Introduction
While technology has been a blessing to the overall population when used correctly, throughout
these tough times, technology is undoubtedly serving a crucial yet vital role in assisting every
area of our life. When we are technologically prepared, our companies and lives operate more
seamlessly. Every day, new technology is developed to keep you active in lockdown situations.
Their major goal is to extend our lives as much as possible. Furthermore, in order to solve these
issues, they aim to keep a smaller but more productive staff. To remain competitive in a postpandemic world, a high level of digital readiness is required. The only reason to remain on the
list beyond the pandemic is to strengthen ourselves so that the financial recession does not have
such a terrible effect on our economy. Although many countries are dissolving as a result of
the crisis, many are aiding others in minimizing their effects due to technological advancement.
A global pandemic has an unforeseen and unpredictable influence on society. The 2020 covid
pandemic occurred in the midst of ongoing digital disruption. Unanticipated quarantines that
disrupted physical societal interactions spurred an increase in IT utilization in both the
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government and industry. Digitisation has become the norm for an appropriate and efficient
workforce. Optimal product performance and service provision were chosen on the spur of the
moment, owing primarily to a unique application of technology in a quickly changing context.
Individuals are more reliant on instant communication and internet access than ever before.
Knowledge that was previously guarded yet distributed locally is now connected and shared
online among people in the digital era like never before. Recognizing the impact of
environmental conditions and physical constraints has resulted in a significant increase in
product innovation and service delivery.
Start with the 2020 pandemic raised public awareness of internet mapping tools, notably the
"dashboard" type tools utilized by various public health organizations throughout several
nations, including the United States and, to a lesser extent, Mexico and others. Several
universities and other research institutions created dashboards with maps and innovative
representations. Such data tools are often cited by public authorities in both policymaking
initiatives and nightly televised briefings
On December 31, 2019, health officials in China reported a pandemic breakout of pneumonia,
the reasons for which were unknown. Following a thorough investigation and the assistance of
the World Health Organization, it has been determined that the unique epidemic is caused by
the SARS-CoV-2 virus, which has the features of fast transmission and the possibility of
mortality. Death is a possibility, particularly in those over 60 or those suffering from underlying
illnesses. Since that time, the viral outbreak has expanded fast, resulting in a global pandemic
that has spread to 188 countries worldwide, making it the biggest health disaster since the 1918
influenza epidemic.
Measures have been done to reduce and restrict the pandemic's impact based on the pandemic's
behavior in various nations. Various health authorities, in particular, sought to limit its
transmission speed and prepare the health system for case treatment, therefore preventing
collapse and lowering the pandemic's social and economic effect. Through history, alienation
has been proven to be the most successful approach for dealing with the spread of an epidemic
while learning from it and developing an appropriate vaccine or treatment to control the
accompanying symptoms. However, decisions that limit mobility have a significant social and
economic impact. Therefore, accurate information is required to choose the best moment to
enter and exit an isolation.
To contextualize this information, interactive data visualizations are required. These
technologies engage not just the public health and scientific groups, but also the general public,
whose participation is critical to effective response efforts. As we apply these technologies to
preserve human lives, we will be able to ingest large amounts of data from their sources and
present the outcomes in interactive dashboards in near real-time.
Power BI (Manohar V et al., 2018) produces visualizations in visual form extremely quickly
and using dashboards and spreadsheets. Using Power BI, the dashboard enables a lot of visuals
to be displayed at a single glance. It's also utilized to highlight only the most important
information, which is frequently modified. Power BI heralds an innovative era. L. Wang et al.
(2015) created a database analysis and visualizing interface that delivers a unified experience
of flexibility and usability.
During the Covid-19 epidemic, these online dashboards have proven to be an invaluable source
of information. The goal of this research is to create a dynamic tool for providing an up-to-date
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report on the condition of Covid-19 based on publicly available data. Several key aspects are
shown to better clarify this virus's behavior. The application has a graphical user interface that
simplifies data streams into content that is simpler to read and comprehend.
1.1. Selection of the software to use Dashboard design and construction
Power BI is a Microsoft suite of business analytics tools being used as a reporting tool and
convey findings in the form of charts and graphs. Power BI receives user data in a variety of
formats, including spreadsheets, text files, databases, and so on. Datasets are created by altering
the information given by users. Users make decisions on data transformations. This step is
designed to eradicate errors and superfluous data, correct layout, and organize data for further
assessment in appropriate normalized formats, among other things. Filtering the data to just
include the important portions Depending on the study and summary that is generated, one may
emphasize precisely the data pertaining to this.
A report can be created by choosing the appropriate option, from a variety of display
components. Power BI visualization components range from displaying a single number to
displaying a gradient-colored map. These visualizations aid in the presentation of data by
providing context and insights. Filters can be added to reports to reveal important data by
utilizing the Quick Insights function, which analyzes data using multiple algorithms and
delivers a collection of reports that it creates automatically.
Dashboards might feature portions of or the entire report after it has been released. By allowing
customers to keep their most critical KPIs in one place, Power BI dashboards provide a 360degree perspective of the data. It is, however, confined to a single page, exposing only the
essential sections of the data to allow viewers to easily form conclusions. It is also feasible to
keep the report and dashboard data up to date in real time and make it available on all platforms
such as PCs and smartphones.
1.2. Getting Started with Power BI
Power BI Desktop is available for free download from the website
https://powerbi.microsoft.com. This is necessary for customers who want to work offline, store
their report files, and then publish them to the online service. It is also intended for data
modeling. There is an online service for the Quick Insight function, as well as a place to
exchange reports and dashboards. The Power BI portal is an excellent place to initiate elearning since it teaches learners all of the main topics of this robust statistical and visualizing
tool.
1.3. Data in Power BI
All the data needs to be imported into Power BI. This is done via the "Get Data" button, which
opens a list of possible data sources. Based on what data source the user chooses, he/she might
be asked to sign in (if needed) or add additional info (for instance, the URL of a SharePoint
list).
After connecting to data sources, a user sees a full report of connected data. If the user chooses,
he/she can modify the data. This is done via the "Home" bookmark. There you need to click
on"Edit Queries". This will open "Power Queries Editor", through which the user can, quite
intuitively, change data types of columns, add, rename, or delete columns or work with "Power
Query M" language capable of handling more sophisticated data transformations.
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When the user is done with data changes, he/she can start creating visualizations. Power BI
offers nineteen different types of visualizations and additional types can be downloaded from
the library.
Filters can be applied to these visualizations. For instance, graphs can be filtered based on the
values in the tables. Created filters can be applied to the entire infographic or just the concrete
visualization.
Usually there 2 ways to distribute completed infographics, the user can either send his/her
infographic in the .pbix file to those concerned or he/she can click on the "Publish" button,
which is hidden under the "Home" bookmark. This will upload the infographic into
"workspace". The user can grant rights to view the infographic in the "workspace" to other
users.
2. Related Literature Review
Since the beginning of the epidemic, several writers have focused on covid. Data on biological
information that has been evaluated is available to researchers. To identify the critical
parameters that might cause a coronavirus outbreak, as well as their medical histories.
Coronavirus transmission may be connected to gender, year of birth, or location of origin,
according to researchers (Al-Rousan and Al-Najjar, 2020). Model SIR is an epidemiological
model that evaluates the theoretical range of individuals diagnosed with an infectious chronic
disease in such a closed society susceptible needs to be applied to individuals who have already
been exposed to the virus and could become carriers if exposed, diagnosed but asymptomatic,
that are people showing symptoms of disease, are infectious. People who have already been
afflicted and may transmit the infection are removed or cured. However, they are no longer
contagious, and the virus has become resistant.
Corona Tracker: Covid Outbreak Data World-Wide Prediction and Study was developed by
Hamzaha et al. in 2020. The need for real-time data was done and displayed, and the desired
data is utilized for statistical modeling for Susceptible-Exposed-Infectious-Recovered (SEIR).
SEIR is a model of covid that was utilized to forecast pandemic outbreaks and observe findings
based on frequent outbreaks inside and outside of China (Hamzaha et al., 2020).
Covid analysis was used in another related effort on data analysis and visualization. Covid was
the topic of the study, which was based on publicly accessible data. In which data analytics on
a number of elements of Covid were provided, including the symptoms of this disease, as well
as the distinction between Covid and other diseases caused by severe diseases, Middle East
Respiratory Syndrome (MERS), acute respiratory syndrome (SARS), and Swine Flu are all
examples of infectious diseases (2020 Khanam et al.). Data visualization on infection
comparisons was provided, indicating that men are much more sensitive to this sickness and
that elderly people are more susceptible to this disease. According to the statistics, the pattern
in the growth of known cases is an inflection point. Furthermore, the proportional number of
cases confirmed, recovered, and fatalities data visualization in the study was presented in
various nations. From February to March 2020, the system operated on real-time data
processing and Covid pandemic prediction, displaying current Covid cases in real-time
(Gamoura, 2020).
During the pandemic outbreak, many researchers emphasized the use of big data, stating that
Covid created a number of barriers to the completion of clinical studies. (Mudr, 2020).
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Mohamed and Abderrahmane were using the SIR model to forecast the Covid epidemic in
Algeria. The study's objective was to anticipate the number of coronavirus infections that will
occur in Algeria on a regular basis. The SIR model was used to provide projections up to 24
April 2020. The outbreak, based on both models' simulations, The Covid peak was projected
to be achieved in the worst-case scenario on July 24, 2020, and the Covid illness is likely to
subside between September 2020 and September 2020. At the very least, November 2020
(Mohamed & Abderrahmane, 2020).
3. Data Visualization and Analysis Tools in Power BI
There are 34 different visualization and analysis tools in the base version of Power BI. Good
data visualization is vital for data analysis and making decisions based on this data. Students
can quickly and easily see and understand different patterns and relationships between data.
They can also uncover developing trends, which in a table or listing of data would go unnoticed.
In most cases, there is no need for special training when it comes to data interpretation from
graphs and graphics.

Image 1: 34 different visualization and analysis tools.

4. Methodology- Data Input into Power BI
The continued development of Covid illness is changing our daily life. We require data
gathering and analysis, as well as visualizations. In this scenario, Power BI is also utilized to
quickly assess data. Visualizations for spreadsheets and dashboards. Power BI assists in the
creation of dashboards that give actionable insights, allowing information to be disseminated
more quickly. Power BI products are frequently utilized in virtualized settings when optimized
with suitable hardware and systems of operation. Power BI can deal with more unordered
Covid data and create a range of representations using Power BI's built-in capabilities.
Furthermore, various techniques for digging through the Covid data would be able to obtain a
significant amount of context. Data exploration in a matter of minutes. Power BI allows
organizations to assess future data without setting any goals. The user-friendly aspect of Power
BI is its investigative visualizations and observative information from multiple methods to
Covid as well as hypothetical visualizations and a function of adding components for
comparison and analysis. Many people believe that the method to begin studying data in Power
BI is to click File > Open. However, these are largely incorrect; File > Open only applies to
current Power BI projects.
Instead, on the main tab, click the Get Data button to import fresh data, then pick the kind of
data source and click Link.
I'm using data from Wikipedia's coronavirus pandemic article and worldometer for my project
report. The first step is to load the data into the Power BI dashboard. Because our data is
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contained on a web page, I may utilize a web data source. Start Power BI Desktop and choose
to Get Data -> Web.

Image 2: Getting data.

Load a file, then go to Get Data and choose the web data type. Enter the reference URL into
the Web source and press OK. On the following step, select Allow Anonymous Access to Web
Content, then click Connect.
It creates a connection to a Web URL. Power BI will return a table as well as a web view of
the web page. Then choose the table containing the data that I want to import for our report.
Table 1 in the picture below includes the necessary data for the covid-19 dashboard.

Image 3: Data Loading for report view.

As a result, the data is immediately imported utilizing transform data, as per our requirements.
Then, when you click on the transformed data, the power query editor opens.

Image 4: Data selection.
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Once the unnecessary columns have been eliminated, the top row may be used as the column
header, click on Use first row as header. It modifies the column header as seen in the image
below.
In the data, the top rows must also be eliminated. Remove Rows -> Remove Top Rows and
enter 1 in the number of rows box, as seen below. As illustrated below, it eliminates the top
row.
A few nations with the name in tiny brackets () are also included in the Location box; the small
brackets text should be removed as well. Select Split Column -> By Delimiter from the context
menu when you right-click on the Location column.
Click custom in the split column by delimiter option and enter a tiny bracket [(] as a delimiter.
We may use the left-most delimiter in this situation since it will split the text on the first
occurrence of a tiny bracket.
When you press the OK button, a new column for divided data will appear.
Remove the new column by right-clicking on it; the data will now appear like this.
Close & Apply should be selected. It saves the data and returns to the designer window; data
fields appear in the image below.

Image 5: Data modification.

4.1. Adding Themes in Power Bi Report
When utilizing Power BI Desktop report themes, design modifications such as adopting
corporate colors, altering icon sets, or applying new default visual formatting will apply to the
whole report.
Report themes may be chosen by going to the View ribbon, then clicking the drop-down arrow
button in the Themes area of the ribbon, and then selecting the desired theme.

Image 6: switch theme button showing different themes.

4.2. Including Visualization of Filled Maps
Click on a filled map visualization icon, modify the map visual's location, then drag the fields
into the field map data columns, as shown below. In the report, we see the following image.
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Rename the column from the map column as shown below. When we move the mouse pointer
over a nation, the information is displayed in a tooltip.

Image 7: example of filled map visualization.

Currently, each nation is represented by a distinct hue in the Power BI Desktop report. We can
use color coding to improve visualization. Navigate to the format section and choose Data
colors->Conditional formatting. Choose a field, such as cases, and then choose the color range
for the least to maximum values. You may customize the color coding to meet your needs. The
color code now allows you to clearly differentiate between the nations.
4.3. Including A Card Representation in The Dashboard
We can include a card in the report to provide information such as the total number of cases
and total recoveries. When you click on a card and enter a field (case), it displays the total
number of cases in the tile.

Image 8: example of card visual.

4.4. In the Visual, Adding Picture of Coronavirus Symptoms and Preventions Guideline
Since we all know, avoidance is preferable to cure. It also pertains to the coronavirus illness.
You could be interested in including such information in your report for the benefit of users. I
deleted the Q&A and card visualization from the report to make it more visually appealing. To
add an image or logo to an existing Power BI dashboard, click on an image in the menu and
navigate to the location of the image.
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Image 9: import the image file.

The image is imported into the Power BI report, and the visualization shows Coronavirus
precautions and signs.
4.5. In Power BI Desktop, Add A Stack Bar Chart Graphic
To begin, go to the Visualization section and select the Stacked Bar Chart. It generates a
Stacked Bar Chart with data automatically, as seen in the picture below.

Image 10: example of stack bar.

4.6. Insert a Tree Map Graphic in Power BI Desktop
Ree-maps represent hierarchical data as a collection of nested rectangles. Each level of the
hierarchy is represented by a colored rectangle (branch) with smaller rectangles within it
(leaves). The measured value determines the size of the space inside each rectangle in Power
BI. The rectangles are arranged in ascending order of size from top left (biggest) to bottom
right (smallest).

Image 11: example of tree map
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Results and Discussion
COVID-19 is spreading at an alarming rate and has significant consequences. The number of
cases with large outbreaks in South Korea, Italy, Iran, the United States, and other countries is
rapidly increasing. Governments are being put to the test by the pandemic's growing highpressure and expenditure levels in terms of public trust and the economy.

Image 12: final dashboard of Coronavirus status

Any mishandling might have political ramifications, as the public will put their legitimacy and
competence into doubt. Transparency is essential and originates inside the government, with
the first epidemic occurring when the public began to react to accountability, thorough and
timely reports and information given. Withholding information has resulted in a vicious circle
of government distrust.

Image 13: Sheet 2 of final dashboard

In order to contain the pandemic, strong leadership is required. Accurate and unambiguous data
are the foundations of the containment effort, which is being supported to guarantee that it is
used and distributed aggressively in any way. In the absence of fact and belief, rumor and
frenzy are inescapable when utilizing social networking to warn the public. People turned out
to be emotional. Such emotions sparked rage and terror, endangering the nation's tranquility.
According to Amesh Adalja, a senior scholar at the Center for Johns Hopkins Health
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Protection, if the public perceives the government response as a setback, skepticism of
prospective public health programs may develop.
Travel bans, border closures, import obstacles, and other things are also on the global agenda.
In response to Covid, containment measures are urgently needed to improve global
preparedness. There is no equitable distribution of the consequences of outbreaks and
epidemics, and the economic impact is also very unexpected. Some industries may even be
lucrative financially, while others may suffer. The vast majority of nations who have been
adversely affected by Covid have established a stimulus package or a strategy for domestic
economic growth in order to boost investment.
Project Restrictions
Although we consider our experience with Power BI to be a success, the tools and the maps
we created have certain limits. The primary issue with PowerBI is the lack of mapping
capabilities, particularly for those who wish to create and distribute polygon/choropleth maps.
Another difficulty with the PowerBI program was our inability to comprehend the method for
automating the data refresh operation. Since the Health Department's data is updated daily, the
maps and visuals must be updated as well. Manually refreshing the data is straightforward, and
for the data supplied by GitHub, the procedure was also quite straightforward. However, there
were some extra procedures for the static data tables saved as Excel files on the Microsoft cloud
drive (One Drive), including the installation of “Gateway” software that allowed PowerBI to
access the files from a cloud drive.
Conclusion
Our mapping effort has a number of ramifications. First, we were able to generate many highquality, dynamic data visualizations of Covid patterns that, we believe, no other public or
commercial research interest or media outlet did throughout 2020. Among the distinctive
aspects of our mapping and data visualization efforts were a country-level map of Covid cases
shown as a clickable point map that was dynamically connected on the ‘dashboard' to a data
table and a trend-line graphic that showed both overall cases and new daily instances.
Another significant aspect of the mapping effort is that we proved that with minimal database
and programming skills, we could create a meaningful, dynamic, and web-enabled set of maps
using free, or at least low-cost software. We were able to discover public data, cleanse it, enter
it into a dynamically connected database structure, and create several representations of the
data within hours after installing the program on standard laptop computers. For simple
visualizations, the PowerBI program proved extremely user-friendly. Although the formulae
required to complete computations between two distinct datasets are similar to those found in
Microsoft Excel, the two more complex visualizations were only achieved after we viewed a
YouTube video or two to understand how to construct a formula in the DAX programming
language. Because of the software's minimal adoption hurdles and mild learning curve, many
beginner data analysts and geographers will be able to grasp the major tasks within hours. There
is other plug-and-play mapping software with "smart" capabilities that allows beginners to
create rudimentary maps, but we are unaware of any other product that combines that capability
with simple database administration and an array of advanced data visualization tools that go
beyond the mapping.
We believe that within a few years, many small businesses, government offices, schools,
researchers, and even ordinary citizens who were previously thwarted in their data sharing,
analysis, and transparency efforts due to the complexity of the software and the logic of
database management will adopt this or similar software platforms. This platform might
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potentially be used as a pedagogical tool, particularly in basic programming, geography, and/or
data visualization courses. With the ease of analyzing, showing, and sharing data, it is possible
that we will see many more efforts like ours in the near future.
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